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Lecture scope
• Introduction to AVR IDE

WinAVR, AVR Studio, MegaLoad

• Historical background
• Digital Electronics

What are gates, three-state logic, flip-flops, latches

• Microprocessor
It’s functional blocks, buses, machine code vs. assembler

• Memory
RAM vs. ROM, Dynamic vs. Static, address decoder

• Microprocessor, memory, I/O devices
How do they communicate?

• Binary data representation
Integers, floating point numbers, alphanumerics, graphics

• Programming
Algorithm, languages, compilation, linking, debugging

• Programmable ICs

Sources of information
• This lecture: http://www.eletel.p.lodz.pl/~pms/dyda_en.html
• H. Feichtinger, Mikrokomputery – poradnik, WKŁ
• P. Misiurewicz, Podstawy techniki mikroprocesorowej, WNT
• R. Baranowski, Mikrokontrolery AVR ATmega w praktyce, BTC
• J. Doliński, Mikrokontrolery AVR w praktyce, BTC
• T. Łuba, K. Jasiński, B. Zbierzchowski,

Specjalizowane układy cyfrowe w strukturach PLD i FPGA, WKŁ
• Standard Digital ICs

– http://www.standardics.philips.com/products/
• AT Mega:

– http://www.atmel.com/
– http://www.avrfreaks.net/
– http://sourceforge.net/projects/winavr/
– http://www.microsyl.com/megaload/megaload.html

• Programmable ICs
– http://www.altera.com/html/literature/
– http://www.latticesemi.com/products/
– http://www.xilinx.com/partinfo/databook.htm
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Milestones
Historical Background

• Abacus - invented 3000 BC in Babylon
• Mechanical arithmometer - independently invented

by Wilhem Schnickard in 1623 and by Blaise Pascal in 1652
• Binary system - mathematical theory of binary system,

Gottfried Wilhelm Leibnitz in 1674
• Tabulator -  a machine for data storage with perforated cards,

invented by Herman Hollerith in 1880, used during the census in USA
• Alan Turing Machine - definition of an algorithm
• Relay based computer - 1935 by Conrad Zuse

Roman and Russian Aacus Tabulator

Arithmometer

(Wikipedia)

Computer Generations

The III generation of computers
• In the late 60s digital integrated circuits (ICs) were developed (containing

several logical gates per one IC). Computers made of such ICs belong to the
third generation of computers.

The IV generation of computers
• Very Large Scale of Integration (VLSI) ICs applied.

(Wikipedia)

The I generation of computers
• Eniac - computer composed of 1800

electron tubes, developed in 1946 by US
Army researchers (occupied 150m3,
energy consumption 50kW, about 10000
simple operations per second)

The II generation of computers
• In 1956 MIT researchers designed and

built the first computer composed of
individual transistors
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Memories

Mechanical - punch cards
Electromechanical - relay based
Ferrite-core memory
Wire memory
Drum memory
...

Semiconductor memory

(Images: Wikipedia)

drum memory

ferrite-core memory

Semiconductor
memory

Micro...

Processor
a module of computer executing a program,
performing computations

Microprocessor
a processor fit in a single IC

Microcomputer
a computer containing a microprocessor

Microprocessors
Microprocessor
• 4-bit microprocessor - 1970, TMS1000 from Texas Instruments
• 8-bit microprocessors - Intel 8008 in 1972, Intel 8080 in 1974, Motorola 6800 ...
• 16-bit... 32-bit... 64-bit microprocessors...
• ...

(Wikipedia)
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Personal Computers

Personal computer
affordable (<$1000) + designed for a home or office use

• Mark 8 (do-it-yourself kit) 1974,
• Altair (do-it-yourself kit), 400$, Intel 8080, 1975,
• Apple, 900$, processor Motorola 6502, 1976,
• IBM PC, 1981,
• Apple, MacIntosh, 1983,
• ...

Digital Logic
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Inverter

Baffer  Inverter

AND  NAND

OR  NOR

EXOR

?

?

?

Connect tables and schematic with appropriate gate
sybmols

Logical Gates

Technology

TTL - NAND
CMOS - NANDCMOS - Inverter

1

1

0

1

10

Logical Gates
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Multiinput logical gates

Logical Gates

Logic functions

Schematic
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Function

Karnaugh Map

b
a

Simplified function and schematic
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Multiplexers

Dual 4-line to 1-line multiplexer with 2 common select inputs
74f153 - http://www.standardics.philips.com/products/

I3 I2 I1 I0
S1

S0

Y

1 0
a

b

Y

c

Connecting inputs and output

• Find out what are the standard
CMOS gates:

– rise/fall times
– delays
– input/output impedances

Output      Input

Logical Gates

E.g. see: http://www.standardics.philips.com/products/
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Connecting outputs together

0 1

Logical Gates

Three-state logic

Logical Gates
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Latches and Flip-flops

RS

D

schematic:
http://www.standardics.philips.com/products/

JK • How D and JK Flip-flop work?
• What is Master-Slave Flip-flop?
• Does the schematic show

M-S Flip-flop?
• What are synchronic circuits?

Introduction to AVR IDE
WinAVR + AVR Studio + MegaLoad
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WinAVR
Desktop

C:\WinAVR\bin

C:\WinAVR\avr\bin

C:\WinAVR\utils\bin

WinAVR: New Project

1. Start Programmers Notepad (PN)
2. Select File->NewProject
3. Create new folder
4. Create new project file
5. Create new C file
6. Save it into a created folder
7. Start MFile
8. Set main file name (created C file)
9. Set MCU to ATMega 128
10. Set optimization level to 0
11. Set Default target to Extended COFF
11. Save makefile into a created folder
12. In PN, add files into the project
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WinAVR: Editing a file

Do not forget to save the edited file!

Schematic of our
ATMega 128 Kit (fragment)
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WinAVR: „Making” the project

MegaLoad: Uploading a program
Do not forget to connect
ATMega Kit (RS1 connector)
with a PC (COM1 or COM2)!

To upload a file push
 a RESET button
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WinAVR � AVR Studio
AVR Studio requires so called
extcoff files. There are several
methods to generate such a file.
Here is one of them:
1. In PN select Tools->Options,
2. Select Tools from the options list
3. Select scheme None-global tools
4. Push Add button
5. Create a MakeCoff tool
    (see the picture for details)
6. A new tool will appear
    on the menu – make use of it!

This step is unnecessary if default “make“
target in makefile is set to Extended COFF

WinAVR � AVR Studio
AVR Studio is a debugging tool for AVR family.
Here is how to load a program created
with WinAVR into the AVR Studio:

1. Start the AVR Studio (ver. 4.07 or later),
2. If a Welcom to window appears, close it,
3. Select File->Open file…
   and load a file with a cof extension,
4. Select a device and debug platform:
   AVR Simulator and ATMega 128
5. After loading the AVR Studio
   is ready for debugging
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AVR Studio: What you need to know

Refer to the AVR Studio’s User Guide and find out:

1. What are these tools for: watch view,
register window, memory window and disassembler?

2. How to run a program, how to stop and reset it?

3. What is a difference between trace into,
step over and step out?
                                  4. What are breakpoints?

Data Representation
in Binary System
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Binary System

A byte is commonly used as a unit of
storage measurement in computers,
regardless of the type of data being stored.
On modern computers, an eight-bit byte or
octet is by far the most common.
(Wikipedia)

In computing, "word" is a term for the natural unit of data used by
a particular computer design. A word is simply a fixed-sized group
of bits that are handled together by the machine. The word size
(or length) is an important characteristic of a computer
architecture.
(Wikipedia)

Binary System
The binary numeral system represents numeric values using two symbols,
typically 0 and 1. More specifically, binary is a positional notation with a
radix of two.  (Wikipedia)

Conversion to a decimal system

1•32 + 0•16 + 0•8 + 1•4 + 1•2 + 0•1 =  38

Conversion to a hexadecimal system

Binary no.:      1001  1101  0110  0001  1110
Hexadecimal      9        D       6        1       E
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Binary System

Fill it in
Convert binary numbers to a decimal and

hexadecimal numbers

110100100100
111111111111
000100000000
000000010000
000011111111

Convert to binary numbers

Decimal no.: 128, 1276, 2048, 17
Hexadecimal no.: 0xFF, 0x1111, 0x81

Binary System
Endianness

Endianness is an arbitrary convention of byte order, required when
integers or any other data are represented with multiple bytes. In such
situations, there are different ways those bytes can be arranged in
memory or in transmission over some medium.

Big-endian
That is, the most significant byte (also
known as the msb) is stored at the
memory location with the lowest
address, the next byte in significance
is stored at the next memory location
and so on.

Little-endian
That is, least significant byte (also
known as lsb) is stored at the memory
location with the lowest address.

Example:
00010111  01101100  = Dec. 5996

Addr. Data
n+2 ...
n+1 00010111
n 01101100
n-1 ...

Addr. Data
n+2 ...
n+1 01101100
n 00010111
n-1 ...
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Signifying negative integers
Two’s complement

Let us count down 9-bit no.:

1 0000 0011 = dec. 259
1 0000 0010 = dec. 258
1 0000 0001 = dec. 257
1 0000 0000 = dec. 256
0 1111 1111 = dec. 255
0 1111 1110 = dec. 254
0 1111 1101 = dec. 253

Now, we remove the 9-th bit:

1 0 000 0011 = dec. 259 - 256 = 3
1 0 000 0010 = dec. 258 - 256 = 2
1 0 000 0001 = dec. 257 - 256 = 1
1 0 000 0000 = dec. 256 - 256 = 0
0 1 111 1111 = dec. 255 - 256 = -1
0 1 111 1110 = dec. 254 - 256 = -2
0 1 111 1101 = dec. 253 - 256 = -3

Sign

Signifying negative integers
Two’s complement

Fill it in
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Calculating two’s complement

Algorithm
1. Invert all the bits (bitwise NOT)
2. Increase the value by one (+1)

Example:

Decimal 12 00001100
Bitwise NOT 11110011
+1 11110100
Decimal  -12

Bitwise NOT 00001011
+1 00001100
Decimal 12

Binary System
Fixed-point positive numbers

Integer:

Let us add a point somewhere in
between the binary digits:

Integer part Fraction part

= Dec. 38

= Dec. 4 3/4

38 • 2-3 = 38 / 8 = 4 3/4
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Binary System
Floating-point numbers

A floating-point number is a digital representation for a number in a certain subset
of the rational numbers, and is often used to approximate an arbitrary real number
on a computer. In particular, it represents an integer or fixed-point number (the
significand or, informally, the mantissa) multiplied by a base (usually 2 in
computers) to some integer power (the exponent). When the base is 2, it is the
binary analogue of scientific notation (in base 10).  (Wikipedia)

Binary System
Floating-point numbers

Single precision (32-bit) IEEE 754 Std. :

Normalised no.    =   (–1)S 2E–127 (1.M)

fraction bitsunsigned integer converted
to a decimal system (0 < E < 255)

Exceptions:
S=0, E=255, M=0  +∞
S=1, E=255, M=0  -∞
E=255 NaN
S=0, E=0, M=0 0
E=0 denormalised no.= 

=(–1)S 2–126 (0.M)
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Binary System
Floating-point numbers

FP    =   (–1)S 2E–127 (1.M)

Example 1:
Convert   1  10000010  110100000...0   to a decimal equivalent

S = 1        E = 100000102 = 130         1.M = 1.11012 = 1 13/16
FP = (-1)1 2 130-127 1.11012 = -23 1.11012 = -1110.12  = -14 1/2

Example 2:
Convert a  π  into a binary single precision number

π = 3.14159265358979 = 3 + 0. 14159265358979 x 223  / 223 =
≈ 3 + 1187765 / 223 = 3 + 0.1001000011111101101012 =
= 11.1001000011111101101012 =
= 2 128-127 1.11001000011111101101012

0   10000000   11001000011111101101010

Binary System
Floating-point numbers

Double precision (64-bit) IEEE 754 Std. :

FP    =   (–1)S 2E–1023 (1.M)
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Binary System
Binary-coded decimals (BCD)

In BCD (SBCD 8421), a digit is usually
represented by four (binary) bits, of
which the leftmost (written
conventionally) has value 8, and the
remaining three have values 4, 2, and 1.
Only the combinations of these bits
which, when summed, have values in
the range 0-9 are valid. (Wikipedia)

(Wikipedia)

Binary System
Binary-coded decimals (BCD)

Example 1:

BCD 1001  0010  0101  0110

Dec.     9       3        5        6

Example 2:

BCD 1011  0010  1101  0110

Dec. Invalid   3   Invalid    6
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Binary System
Alphanumerics and texts

American Standard Code for Information Interchange (ASCII) is the numerical representation
of an alphanumeric  (e.g.: 'a ', '5' or ’#’) or an action of some sort.
ASCII was published in 1963 (uppercase letters defined) and in 1967.

Binary System
Alphanumerics and texts

Example:

10001110   1101111   01101111   01100100   00001101   00001010

G                o               o                  d                 [CR]            [LF]

1100111   01110101   01111001   01110011   00000000
g                 u                   y                    s                   [NULL]

End of text string in C

Starting a new line
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Binary System
Alphanumerics and texts

Ascii was very simplistic (7-bit codes), and so was extended by adding 'extended'
sets by various manufacturers. Apart from being confusing this was still restricted
to 256 characters (8-bit codes). Now computers are more widely established around
the world the need to show other characters such as Japanese and Chinese
languages along with various symbols became more important.

Unicode (usually 16-bit codes) is an attempt to standardize every character possible.
(http://www.lookuptables.com/)

Refer to:

•  http://www.lookuptables.com/

•  http://www.unicode.org/

Images and Graphics
Raster Images

Image Data
FF FF FF FF 4F 4F 4F 4F FF FF FF FF FF FF FF FF

FF FF 31 FF FF 4F 4F FF FC FC FC FC FF FF FF FF

FF 30 35 35 37 37 FF FF FF BA BA FC FC FF FF FF

FF 30 35 35 37 37 37 FF FF FF BA BA FC FC FF FF

FF FF 35 35 35 37 37 37 FF FF FF BA BA FC FC FF

FF FF 31 35 35 35 37 37 37 37 FF BA BA BA FC FF

FF FF 30 35 35 35 35 37 37 37 37 FF BA BA FC FC

FF FF 4F 30 35 35 35 35 37 37 37 BA BA BA FC FC

FF FF 4F 30 30 35 35 35 35 37 37 BA BA BA FC FC

FF FF 4F 4F 30 30 35 35 4F 37 37 37 BA BA FC FC

FF FF FF 4F 4F 4F 30 30 4F FF 37 37 BA BA BA FC

FF FF FF 4F 4F 4F 4F 30 4F 4F FF FF BA BA FF FC

FF FF FF FF 4F 4F 4F 4F 4F 4F 4F FF BA BA FF FC

FF FF FF FF FF FF FF 4F 4F 4F 4F FF BA BA FF FF

FF FF FF FF FF FF FF 4F 4F 4F 4F FF FF FF FF FF

FF FF FF FF FF FF FF FF 4F 4F 4F 4F 4F FF FF FF

Palette
LUT

40 00 40
40 60 00
40 40 80
00 40 40
A0 00 40
40 C0 00
40 40 E0

     ...
     ...
     ...

Header
42 4D 36 05 00 00 00 00 00 00 36 04 00 00 28 00
00 00 10 00 00 00 10 00 00 00 01 00 08 00 00 00
00 00 00 01 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 80 00 00 80
00 00 00 80 80 00 80 00 00 00 80 00 80 00 80 80

Pixel

A raster graphics image is a data file or structure representing a generally
rectangular grid of pixels, or points of color. The color of each pixel is
individually defined.



29

Images and Graphics
Vector Graphics

SetPixelV(kontekst, x, y, RGB(r, g, b));
MoveToEx(kontekst, x, y, NULL);
LineTo(kontekst, x, y);
Rectangle(kontekst, x1, y1, x2, y2);

Vector graphics or geometric modeling is the use of geometrical
primitives such as points, lines, curves, and polygons to represent
images in computer graphics. It is used by contrast to the term
raster graphics, which is the representation of images as a
collection of pixels (dots).

Sound

Sampling and digitizing the sound wave

....  10000010  11010000   ....
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I/O Device Programming

ATMega 128 Kit
 Display and Keybord

ATMega 128 Kit
Display

1. Schematic of ATMega 128 ports,
2. I/O Ports registers (PORTx, DDRx),
3. HD44780 pins and their functions,
4. Four and eight bit data bus configuration,
5. Sending instructions, configuring the LCD driver,
6. Sending alphanumeric codes.

Lecture based on documentation of microcontroller ATMega 128 from ATMEL®
and alphanumeric liquid-crystal display driver HD44780U from Hitachi®.

(ATMEL)

(Hitachi)

(P. Romaniuk, P. Skulimowski)
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1. Keybord schematic,
2. Methods for idendification
    the key being pressed,
3. ATMega 128 port schematic
    (pull up resistors),
4. Function of port registers
    (PINx, SFIOR bit PUD).

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL®

1 1 0 1

1

1

1

1

1 1 0 1

1

1

1

1

1 1 0 1

1

0

1

1

1

1

1

1

(ATMEL)

ATMega 128 Kit
Keybord

Computer Architecture
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Computer Architecture
Interrupt

DMA request/enable

Read/Write

Address bus

Data bus

Select
CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Computer Architecture
Address, Data & Control Bus (Read/Write signals)

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

An address bus is used by CPUs or DMA-capable units for communicating the physical
addresses of computer memory elements (location) that the requesting unit wants to access
(read or write). The width of an address bus, along with the size of addressable memory
elements, determines how much memory can be accessed.

A data bus (connections between and within the CPU, memory, and peripherals) is used to carry
data.

A control bus is used by CPUs for communicating with other devices within the computer. While
the address bus carries the information on which device the CPU is communicating with and the
data bus carries the actual data being processed, the control bus carries commands from the
CPU and returns status signals from the devices, for example if the data is being read or written
to the device the appropriate line (of a control bus) will be active.

In computer architecture, a bus is a subsystem that
transfers data or power between computer
components inside a computer or between
computers. A bus (address bus, data bus) is usually
a group of parallel wires connecting different parts of
a circuit with each individual wire carrying a different
logic signal.

Where?

What?

How?
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Computer Architecture
The term von Neumann architecture refers to a computer design model that uses a single
storage structure to hold both instructions and data. The term von Neumann machine can
be used to describe such a computer, but that term has other meanings as well. The
separation of storage from the processing unit is implicit in the von Neumann architecture.

The term Harvard architecture originally referred to computer architectures that used
physically separate storage and signal pathways for their instructions and data (in contrast
to the von Neumann architecture). The term originated from the Harvard Mark I relay-based
computer, which stored instructions on punched tape (24-bits wide) and data in relay
latches (23-digits wide).
Memory can be made much faster, but only at high cost. The solution then is to provide a small amount of
very fast memory known as a cache. As long as the memory that the CPU needs is in the cache, the
performance hit is much smaller than it is when the cache has to turn around and get the data from the
main memory. Tuning the cache is an important aspect of computer design.
Modern high performance CPU chip designs incorporate aspects of both Harvard and von Neumann
architecture. On chip cache memory is divided into an instruction cache and a data cache. Harvard
architecture is used as the CPU accesses the cache. In the case of a cache miss, however, the data is
retrieved from the main memory, which is not divided into separate instruction and data sections. Thus a
von Neumann architecture is used for off chip memory access.

(Wikipedia)

Computer Architecture
Example: Intel 8051

Separate signals 
for program code

and data

Separate storage
(memories)

for program code
and data

Harvard
architecture
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Computer Architecture
Example: Intel 8051

von Neumann
architecture

Address 
Decoder

64 KB 64 KB
32 KB

32 KB

Computer Architecture
Microprocessor (CPU)

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

A central processing unit (CPU) refers to
part of a computer that interprets and
executes instructions

Motorola 6800 (H. Feichtinger, Mikrokomputery – poradnik)
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Computer Architecture
Memory

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Semiconductor Memory

RAM
Random-access Memory

ROM
Read-only Memory EPROM

Erasable 
Programmable 

ROM
SRAM
Static NVRAM 

Non-volatile

DRAM
Dynamic

EEPROM
Electrically 

Erasable ROM

PROM
Programmable 

ROM

EAROM
Electrically 

Alterable ROMFIFO

SDRAM

Rambus

DDR

Computer Architecture
RAM - Static vs. Dynamic

TTL                       MOS
Static memory cell

Dynamic memory cell

The static RAM retains
its contents as long as
power remains applied.
- Fast,
- Low density.

The Dynamic RAM
needs to be periodically
refreshed.
- Slow,
- High density.

Column and Row Address Strobes

What are the storage sizes (in Bytes) of the above
Static and Dynamic memories?
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Computer Architecture
FIFO

FIFO (First In, First Out) memory stores the
data in queue order so the first input
element goes out the first. FIFO memory
chips are used in buffering applications
between devices that operate at various
speeds.

MSM518221A (OKI Semiconductor)

Dual data interface:
•Input 

•Output 

Computer Architecture
Dynamic RAM: SDRAM, DDR RAM

Synchronous Dynamic (SD) RAM is an improved type of DRAM. Whilst DRAM has an
asynchronous interface, meaning that it reacts immediately to changes in its control inputs,
SDRAM has a synchronous interface, meaning that it waits for a clock pulse before
responding to its control inputs. The clock is used to drive an internal finite state machine
that can pipeline incoming commands. This allows the chip to have a more complex pattern
of operation than plain DRAM.
Double data rate (DDR) SDRAM is a later development of SDRAM, used in PC memory
from 2000 onwards. All types of SDRAM use a clock signal that is a square wave. This
means that the clock alternates regularly between one voltage (low) and another (high),
usually millions of times per second. Plain SDRAM, like most synchronous logic circuits,
acts on the low-to-high transition of the clock and ignores the opposite transition. DDR
SDRAM acts on both transitions, thereby halving the required clock rate for a given data
transfer rate.
Direct Rambus DRAM (DRDRAM), often called RDRAM, is internally similar to DDR
SDRAM, but uses a special method of signaling developed by the Rambus Company that
allows faster clock speeds.

(Wikipedia)



37

Computer Architecture
PROM, EPROM, EEPROM

PROMs (Programmable Read-Only Memory) can be programmed via a special device, a
PROM programmer. The writing often takes the form of permanently destroying or creating
internal links (fuses or antifuses) with the result that a PROM can only be programmed once.

EPROMs (Erasable Programmable
Read-Only Memory) can be erased
by exposure to ultraviolet light then
rewritten via an EPROM programmer.
Repeated exposure to ultraviolet light
will eventually destroy the EPROM
but it generally takes many exposures
before the EPROM becomes unusable.      Floating gate MESFET

EAROMs (Electrically Alterable Read-Only Memory) can be modified a bit at a time, but writing
is intended to be an infrequent operation; most of the time the memory is used as a ROM.
EAROM may be used to store critical system setup information in a non-volatile way. For many
applications, EAROM has been supplanted by CMOS RAM backed-up by a lithium battery.
EEPROM such as Flash memory (Electrically Erasable Read-Only Memory) allow the entire
ROM (or selected banks of the ROM) to be electrically erased (flashed back to zero) then
written to without taking them out of the computer (camera, MP3 player, etc.). Flashing is much
slower than writing to RAM (Random Access Memory) (or reading from any ROM).

(Wikipedia)

PN N

Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

I/O devices are used by a person (or other
system) to communicate with a computer. For
instance, keyboards and mice are considered
input devices of a computer and monitors and
printers are considered output devices of a
computer. Typical devices for communication
between computers are for both input and output,
such as modems and network cards.
In computer architecture, the combination of the
CPU and main memory is considered the heart
of a computer, and any movement of information
from or to that complex, for example to or from a
disk drive, is considered I/O.

(Wikipedia)

I/O communication methods:
•Memory-mapped I/O (MMIO) and port-mapped I/O (PMIO)
•Direct memory access (DMA) 
•Interrupt 
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Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Memory-mapped I/O uses the same bus
to address both memory and I/O devices,
and the CPU instructions used to read and
write to memory are also used in
accessing I/O devices. In order to
accommodate the I/O devices, areas of
CPU addressable space must be reserved
for I/O rather than memory. The I/O
devices monitor the CPU's address bus
and respond to any CPU access of their
assigned address space, mapping the
address to their hardware registers.

Port-mapped I/O uses a special class of CPU instructions specifically for performing
I/O. This is generally found on Intel microprocessors, specifically the IN and OUT
instructions which can read and write a single byte to an I/O device. I/O devices
have a separate address space from general memory, either accomplished by an
extra "I/O" pin on the CPU's physical interface, or an entire bus dedicated to I/O.

(Wikipedia)

Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Direct memory access (DMA) allows
certain hardware subsystems within a
computer to access system memory for
reading and/or writing independently of
the CPU.

Control signals:
•DMA Request
•DMA Enable
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Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

DMA Controller

DMA Controller Master-Slave configuration

Intel 8086

Example: IMB PC DMA system

Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Processors also often have a mechanism referred to as interrupt disable which
allows software to prevent interrupts from interfering with communication
between interrupt-code and non-interrupt code. Typically, the user can
configure the machine using hardware registers so that different types of
interrupts are enabled or disabled, depending on what the user wants
(maskable interrupts). Some interrupts cannot be disabled - these are referred
to as non-maskable interrupts.

(Wikipedia)

Interrupts: Digital computers usually
provide a way to start software routines in
response to asynchronous electronic
events. These events are signaled to the
processor via interrupt requests (IRQ). The
processor and interrupt code make a
context switch into a specifically written
piece of software to handle the interrupt.
This software is called the interrupt service
routine, or interrupt handler.
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Computer Architecture
Communication with I/O Devices

CPU Oscillator

RAM

ROM

DMARegistersInterrupts

I/O Devices

Address 
Decoder

Interrupt Controller

Intel 8086

Interrupt Controller Master-Slave configuration

Example: IMB PC Interrupt system

ATMega 128
Memories
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ATMega 128
Memories

1. Flash Program Memory,
2. SDRAM Data Memory,
3. EEPROM Data Memory,
4. External Data Memory Interface.

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

(ATMEL)

128KB = 16 x 64K

(ATMEL)

EEPROM
4KB

Is it a von Neumann or
 Harvard architecture?

Is it a MMIO or PMIO?

ATMega 128
Memories

1. Flash Program Memory,
2. SDRAM Data Memory,
3. EEPROM Data Memory,
4. External Data Memory Interface.

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

(ATMEL)(ATMEL)
(ATMEL)
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Interrupt system
of ATMega 128

ATMega 128
Interrupt system

1. Interrupt vectors table,
2. Table placement,
3. Programming
    the interrupt handler.

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

(ATMEL)

Global
variables

Interrupt
handler

Configuring a
device sending 
interrupt signal
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ATMega 128 CPU Core

ATMega 128
CPU Core

1. Arithmetic-Logic Unit,
2. General Purpose Registers,
3. Indexing Registers,
4. Status (Flag) Register,
5. Stack & Stack Pointer Register,
6. Instruction Execution Timings.

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

(ATMEL)

(ATMEL)

(ATMEL)



44

CPUs
Some Definitions

CPUs
Instruction Sets (RISC, CISC...)

Reduced Instruction Set Computer (RISC) is a microprocessor CPU design
philosophy that favors a smaller and simpler set of instructions. Properties:

•All the instructions take about the same amount of time to execute
•Typically most of the instruction codes are of a fixed length
•The total number of instructions read from memory is high

Complex Instruction Set Computer (CISC) is a CPU design in which each
instruction can execute several low-level operations, such as a load from
memory, an arithmetic operation, and a memory store, all in a single
instruction. Properties:

•Usually instruction codes are of a variable length
•Smaller program sizes and fewer calls to program memory

Very Long Instruction Word (VLIW) is a design of a microprocessor that packs
many simple RISC-like instructions into a much longer internal instruction
word format. A VLIW microprocessor will usually have execution units,
capable of executing all of the instructions contained in the instruction word, in
parallel. Explicitely Parallel Instruction Computing (EPIC) is an Intel’s acronym
for VLIW.



45

CPUs
Instruction Pipeline

An instruction pipeline is a technology used to enhance microprocessors
performance. Pipelining greatly improves throughput at a small cost in
latency.

Execution of CPU instruction consist of a number of steps:
•Read the next instruction
•Read the operands, if any
•Execute the instruction
•Write the results back out

Non-pipelined processors did only one instruction at a time. Since each
step of an instruction is performed by a different piece of hardware, the
CPU may start executing the next instruction before accomplishing the
previous one.

CPUs
Scalar vs. Superscalar

A superscalar CPU architecture implements a form of
parallelism on a single chip, thereby allowing the system
as a whole to run much faster than it would otherwise be
able to at a given clock speed. The term is a modification
of scalar, processors that run one instruction per clock
cycle, themselves a step up from earlier processors that
would take a variable number of cycles to complete any
given operation.
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CPUs
SIMD

Single Instruction, Multiple Data (SIMD). It is a computing term that
refers to a set of operations for efficiently handling large quantities of
data in parallel, as in a vector processor or array processor

Example: Intel Pentium II and III SIMD technologies:

Multi-Media eXtensions (MMX) is instructions extension intended to enhance
programs that have multi-media capabilities. MMX is SIMD for integer numbers.

Streaming SIMD Extensions (SSE) is a SIMD instructions extension for single-
precision floating-point numbers.

Assembly Language
Programming
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Assembly Programming
Opcode (Machine Code) vs. Mnemonic (Assembly)

A system of codes directly understandable by a computer's CPU is termed this CPU's
native or machine language (or machine code).

An Opcode is the portion of a machine language instruction that specifies the operation
to be performed. The term is an abbreviation of Operation Code.

Assembly language or simply assembly is a human-readable notation for the machine
language that a specific computer architecture uses. Machine language, a pattern of bits
encoding machine operations, is made readable by replacing the raw values with
symbols called mnemonics.

Mnemonic is a code, usually from 1 to 5 letters, that represents an opcode, a number. A
mnemonic is usually followed by a list of arguments.

    Programming in machine code, by supplying the computer with the numbers of the operations it
must perform, can be quite a burden, because for every operation the corresponding number must be
looked up or remembered. Looking up all numbers takes a lot of time, and misremembering a number
may introduce computer bugs.
    Therefore a set of mnemonics was devised. Each number was represented by an alphabetic code.
So instead of entering the number corresponding to addition to add two numbers one can enter "add".
  Although mnemonics differ between different CPU designs some are common, for instance: "sub"
(subtract), "div" (divide), "add" (add) and "mul" (multiply).

(Wikipedia)

(Borland C++ Builder CPU window)

(AVRStudio disassembler window)

AVR ATMega 128

Intel Pentium Processor

Is it CISC or RISC?

Assembly Programming
Opcode (Machine Code) vs. Mnemonic (Assembly)

Address Opcode   Mnemonic Argument(s)
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Assembly Programming
Assembly Language

Assembly language or simply assembly is a human-readable notation for the
machine language that a specific computer architecture uses. Machine language, a
pattern of bits encoding machine operations, is made readable by replacing the
raw values with symbols called mnemonics.
An assembler is a computer program for translating assembly language —
essentially, a mnemonic representation of machine language — into object code. A
cross assembler (see cross compiler) produces code for one type of processor, but
runs on another.

Every computer architecture has its own machine language, and therefore its own assembly language.
Computers differ by the number and type of operations that they support. They may also have different
sizes and numbers of registers, and different representations of data types in storage. While all general-
purpose computers are able to carry out essentially the same functionality, the way they do it differs, and
the corresponding assembly language must reflect these differences.

Transforming assembly into machine language is accomplished by an assembler, and the reverse by a
disassembler. Unlike in high-level languages, there is usually a 1-to-1 correspondence between simple
assembly statements and machine language instructions.

(Wikipedia)

Assembly Programming
Instruction Groups

•Arithmetic and Logic Instructions
•Branch Instructions
•Data Transfer Instructions
•Bit and Bit Test Instructions
•MCU Control Instructions (ATMEL)
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Assembly Programming
Instruction Groups

•Arithmetic and Logic Instructions
•Branch Instructions (Jumps)
•Data Transfer Instructions
•Bit and Bit Test Instructions
•MCU Control Instructions

(ATMEL)

Assembly Programming
Instruction Groups

(ATMEL)

•Arithmetic and Logic Instructions
•Branch Instructions (Jumps)
•Data Transfer Instructions
•Bit and Bit Test Instructions
•MCU Control Instructions
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Assembly Programming
Instruction Groups

(ATMEL)

•Arithmetic and Logic Instructions
•Branch Instructions (Jumps)
•Data Transfer Instructions
•Bit and Bit Test Instructions
•MCU Control Instructions

Assembly Programming
Instruction Groups

(ATMEL)

•Arithmetic and Logic Instructions
•Branch Instructions (Jumps)
•Data Transfer Instructions
•Bit and Bit Test Instructions
•MCU Control Instructions
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Assembly Programming
Addressing Modes

Addressing modes form part of the instruction set architecture for some particular
types of CPU. Some machine languages will need to refer to (addresses of)
operands in memory. An addressing mode specifies how to calculate the effective
memory address of an operand by using information held in registers and/or
constants contained within a machine instruction.

Examples of addressing modes:
Absolute or Direct -- effective address given in instruction
Relative -- effective address is a given offset plus address of next instruction
Indirect -- effective address is contents of a memory at a given address
Base plus offset -- effective address is offset plus contents of specified register
Immediate -- operand given within a program code
Register -- argument within a register
Register indirect -- effective address is contents of specified register
Indexed absolute -- effective address is address given in instruction plus contents of specified
index register
Autoincrement(decrement) -- base plus index plus the register is in(de)cremented

What are addressing modes of ATMega 128?

Assembly Programming
Program Line

(AVRStudio Tools User Guide)

An input line may take one of the four following forms: 

[label:] directive [operands] [Comment]
[label:] instruction [operands] [Comment]
Comment
Empty line

A comment has the following form: 

; [Text]
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Assembly Programming
Labels

A label is usually an address identifier in programming language 

Examples:
var1: .BYTE 1 ; reserve 1 byte to var1
table: .BYTE tab_size ; reserve tab_size bytes

label: .EQU var1=100 ; Set var1 to 100

test: rjmp test ; Infinite loop

(AVRStudio Tools User Guide)

Assembly Programming
Constants

The EQU directive assigns a value to an identifier. This identifier can then
be used in later expressions. An identifier assigned to a value by the EQU
directive is a constant and can not be changed or redefined.

Syntax:
.EQU identifier = expression

Example:
.EQU io_offset = 0x23
.EQU porta = io_offset + 2

.CSEG ; Start code segment
clr r2 ; Clear register 2
out porta,r2 ; Write to Port A

(AVRStudio Tools User Guide)
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Assembly Programming
Variables

Examples:

var1: .BYTE 1 ; reserve 1 byte to var1
table: .BYTE tab_size ; reserve tab_size bytes

(AVRStudio Tools User Guide)

Assembly Programming
Procedures

Example:
; main program
...
rcall procedure_name
...

procedure_name:
...
; procedure body here
call other_procedure_name
...
ret

other_procedure_name:
...
; procedure body here
...
ret

What is a stack? How call and ret instructions use a stack?
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Assembly Programming
Macros

Example:

.MACRO SUBI16 ; Start macro definition
subi @1,low(@0) ; Subtract low byte
sbci @2,high(@0) ; Subtract high byte

.ENDMACRO ; End macro definition

.CSEG ; Start code segment
SUBI16 0x1234,r16,r17 ; Sub.0x1234 from r17:r16

(AVRStudio Tools User Guide)

Assembly Programming
Procedures vs. Macros

Procedure:
slower execution (additional execution of call/ret instructions)
smaller code (appears only in one location in the object code)

Macro:
faster execution (it is pasted into a code, immediately executed)
larger code (appears in many places in the object code)
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Assembly Programming
Directives

The Assembler supports a number of
directives. The directives are not
translated directly into opcodes.
Instead, they are used to adjust the
location of the program in memory,
define macros, initialize memory and
so on. An overview of the directives is
given in the following table.

(AVRStudio Tools User Guide)

Directive Description
BYTE Reserve byte to a variable
CSEG Code Segment
CSEGSIZEProgram memory size
DB Define constant byte(s)
DEF Define a symbolic name on a register
DEVICE Define which device to assemble for
DSEG Data Segment
DW Define Constant word(s)
ENDM End macro
EQU Set a symbol equal to an expression
ESEG EEPROM Segment
EXIT Exit from file
INCLUDE Read source from another file
LIST Turn listfile generation on
LISTMAC Turn Macro expansion in list file on
MACRO Begin macro
NOLIST Turn listfile generation off
ORG Set program origin
SET Set a symbol to an expression

Assembly Programming
Expressions

(AVRStudio Tools User Guide)

The Assembler
incorporates expressions.
Expressions can consist of
operands, operators and
functions.

Operators
    Symbol Description

! Logical Not
~ Bitwise Not
- Unary Minus
* Multiplication
/ Division
+ Addition
- Subtraction
<< Shift left
>> Shift right
< Less than
<= Less than or equal
> Greater than
>= Greater than or equal
== Equal
!= Not equal
& Bitwise And
^ Bitwise Xor
| Bitwise Or
&& Logical And
|| Logical Or

Functions
LOW(expression) returns the low byte of an expression 
HIGH(expression) returns the second byte of an expression 
BYTE2(expression) is the same function as HIGH 
BYTE3(expression) returns the third byte of an expression 
BYTE4(expression) returns the fourth byte of an expression 
LWRD(expression) returns bits 0-15 of an expression 
HWRD(expression) returns bits 16-31 of an expression 
PAGE(expression) returns bits 16-21 of an expression 
EXP2(expression) returns 2 to the power of expression 
LOG2(expression) returns the integer part of log2(expression) 

Is the ‘+’ operator translated into add opcode?
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Assembly Programming
Assembly Project in AVR Studio

1. Start AVR Studio
2. Select Project->NewProject
3. Check Create initial File and Create Folder
4. Fill in Project Name and Initial File
5. Press Finish button
6. Edit an assembly source file
7. Build the project

Assembly Programming
Assembly Project in AVR Studio

Example:
1. Start AVR Studio
2. Select Project->NewProject
3. Check Create initial File and Create Folder
4. Fill in Project Name and Initial File
5. Press Finish button
6. Edit an assembly source file
7. Build the project
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Assembly Programming
C and Assembly Language (WinAvr)

In C language asm keyword can be used to place assembly language
statements in the middle of a C source code.

Assembly language statements in GCC compiler take a form:
asm("instruction [operands]");

Example:

Assembly Programming
C and Assembly Language (WinAvr)

Procedures written in assembly language defined within a separate *.asm file
can be added to a WinAvr project and called from a C file.

1. Create a new *.asm file and add it to the project,
2. Edit a *.asm file and define a procedure to be called from a C source code,
3. Declare a procedure within a C file,
4. List a *.asm file within the project’s Makefile
5. Call a assembly procedure from a C source code
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Assembly Programming
C and Assembly Language (WinAvr)

Example:

Analog-Digital Converter
 of ATMega 128
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(Piotr Skulimowski, Piotr Romaniuk)

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

ADC of ATMega 128

1. Analog signal connector of the Kit,
2. Clock frequency,
3. ADC characteristics,
4. Analog channels & gain select,
7. ADC voltage reference selection,
5. Single conversion & free running mode,
6. Prescaling and conversion timing,
7. Conversion result,
8. ADC registers: ADMUX, ADCSRA, ADC

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

ADC of ATMega 128

1. Analog signal connector of the Kit,
2. Clock frequency,
3. ADC characteristics,
4. Analog channels & gain select,
7. ADC voltage reference selection,
5. Single conversion & free running mode,
6. Prescaling and conversion timing,
7. Conversion result,
8. ADC registers: ADMUX, ADCSRA, ADC

(ATMEL)

(ATMEL)
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(ATMEL)

Lecture based on documentation
of microcontroller ATMega 128 from ATMEL® .

ADC of ATMega 128

1. Analog signal connector of the Kit,
2. Clock frequency,
3. ADC characteristics,
4. Analog channels & gain select,
7. ADC voltage reference selection,
5. Single conversion & free running mode,
6. Prescaling and conversion timing,
7. Conversion result,
8. ADC registers:

ADMUX, ADCSRA, ADC.

(ATMEL)


